37 SENSOR KIT TUTORIAL
FOR UNO AND MEGA
Preface

Our Company

Established in 2011, Elegoo Inc. is a professional manufacturer and exporter that is involved in the design, development, production and marketing of Arduino accessories, 3D printers, Raspberry Pi accessories and STM32. We are located in Shenzhen which is known as the Chinese Silicon Valley. All of our products comply with international quality standards and are greatly appreciated in a variety of different markets throughout the world.

Official website: http://www.elegoo.com

US Amazon store front: http://www.amazon.com/shops/A2WWHQ25ENKVJ1
CA Amazon store front: http://www.amazon.ca/shops/A2WWHQ25ENKVJ1
DE Amazon Store front: http://www.amazon.de/shops/A1780XYQ9DFQM6
Vitrine à l’Amazon FR: http://www.amazon.fr/shops/A1780XYQ9DFQM6
Tienda de Amazon de ES.: http://www.amazon.es/shops/A1780XYQ9DFQM6
IT Amazon negozio: http://www.amazon.it/shops/A1780XYQ9DFQM6
UK Amazon storefront: http://www.amazon.co.uk/shops/A1780XYQ9DFQM6

Our Tutorial

This tutorial is geared for beginners. You will learn all the basic information about how to use Arduino controller board, sensors and components. If you want to study Arduino in more depth, we recommend that you read the Arduino Cookbook written by Michael Margolis.

Our after-sales

If you have any question, comment or suggestion about our company, product or tutorial, please don’t hesitate to send an email to service@elegoo.com (US and CA) or EUservice@elegoo.com (Europe). We are committed to continuous improvement so your feedback is invaluable.
Packing List

- JOYSTICK
- FLAME
- RGB LED
- RELAY
- LINEAR HALL
- SMD RGB
- BIG SOUND
- Mental TOUCH
- TWO-COLOR
- SMALL SOUND
- DIGITAL TEMPERATURE
- MINI TWO-COLOR
- TRACKING
- Native BUZZER
- Magnetic spring
- AVOIDANCE
- PASSIVE BUZZER
- Mini reed switch
Lesson Listing

Lesson 0 Installing IDE .............................................................................................................6
Lesson 1 Add Libraries ...........................................................................................................14
Lesson 2 TEMP AND HUMIDITY MODULE .............................................................................18
Lesson 3 DS18B20 DIGITAL TEMPERATURE SENSOR MODULE ........................................24
Lesson 4 BUTTON SWITCH MODULE ......................................................................................30
Lesson 5 FOUR TYPE OF SWITCH MODULE ...........................................................................34
Lesson 6 IR RECEIVER AND EMISSION ...............................................................................43
Lesson 7 Active and passive buzzer ........................................................................................51
Lesson 8 LASER MODULE ......................................................................................................58
Lesson 9 SMD RGB MODULE AND RGB MODULE ..................................................................62
Lesson 10 PHOTO-INTERRUPTER MODULE ..........................................................................69
Lesson 11 DUAL-COLOR COMMON-CATHODE LED ...............................................................74
Lesson 12 PHOTORESISTOR MODULE .....................................................................................80
Lesson 13 BIG SOUND SENSOR MODULE AND SMALL SOUND SENSOR MODULE ...............86
Lesson 14 REED SWITCH AND MINI REED SWITCH MODULE ...............................................92
Lesson 15 DIGITAL TEMPERATURE MODULE .......................................................................101
Lesson 16 LINEAR HALL AND ANALOG HALL MODULE ......................................................108
Lesson 17 FLAME SENSOR MODULE .....................................................................................117
Lesson 18 MENTAL TOUCH MODULE .....................................................................................122
Lesson 19 7 COLOR FLASH LED MODULE .............................................................................127
Lesson 20 Magic light cup MODULE ........................................................................................131
Lesson 21 JOYSTICK MODULE ................................................................................................135
Lesson 22 TRACKING MODULE ...............................................................................................140
Lesson 23 Infrared 38KHz obstacle avoidance module .............................................................144
Lesson 24 ROTARY ENCODERS MODULE ..............................................................................150
Lesson 25 1 CHANNEL RELAY MODULE ..............................................................................156
Lesson 26 HEARTBEAT MODULE ............................................................................................161
Lesson 0 Installing IDE

Introduction

In this lesson, you will learn how to setup your computer to use Arduino and how to set about the lessons that follow.

The Arduino software that you will use to program your Arduino is available for Windows, Mac and Linux. The installation process is different for all three platforms and unfortunately there is a certain amount of manual work to install the software. There is no installer program, but rather you have to unzip a folder which gives you an Arduino folder that contains the Arduino program and a few other items.

In a separate step, you must then install USB drivers,

Installing Arduino (Windows)

Get started by visiting the Arduino.cc website. As of April 2014, we suggest using v1.05 as 1.5 is still in beta. If 1.5 is no longer in beta by the time you read this, you can try it out!

Start by downloading the zip file for Windows. There is only one version of the software, whether you are using Windows XP through to Windows 7.

When the zip file has downloaded, extract the contents onto the Desktop, by right-clicking
on the file and selecting 'Extract All...' from the pop-up menu.

Next, select your Desktop and click 'Extract'. You can move it somewhere else onto your computer later, just by moving the folder, but for now, just keep it on the Desktop.

The Arduino folder contains both the Arduino program itself and the drivers that allow the Arduino to be connected to your computer by a USB cable. Before we launch the Arduino software, you are going to install the USB drivers.

Plug one end of your USB cable into the Arduino and the other into a USB socket on your computer. The power light on the LED will light up and you may get a 'Found New Hardware' message from Windows. Ignore this message and cancel any attempts that Windows makes to try and install drivers automatically for you.

The most reliable method of installing the USB drivers is to use the Device Manager. This is accessed in different ways depending on your version of Windows. In Windows 7, you first have to open the Control Panel, then select the option to view Icons, and you should find the Device Manager in the list.

Under ‘Other Devices’, you should see an icon for ‘unknown device’ with a little yellow warning triangle next to it. This is your Arduino.
Right-click on the device and select the top menu option (Update Driver Software...). You will then be prompted to either ‘Search Automatically for updated driver software’ or ‘Browse my computer for driver software’. Select the option to browse and navigate to the arduino-1.0.2-windows\arduino1.0.2\drivers.
Click ‘Next’ and you may get a security warning, if so, allow the software to be installed. Once the software has been installed, you will get a confirmation message.

That’s it, you are now ready for action, so Skip the next section on installation on Mac and Linux and move straight on to ‘Boards and Ports’.

**Installing Arduino (Mac and Linux)**

Get started by visiting the Arduino.cc website and downloading the matching IDE for your operating system. As of April 2014, we suggest using v1.05 as 1.5 is still in beta. If 1.5 is no longer in beta by the time you read this, you can try it out!
Save the install software to your desktop or wherever

The process for installing the Arduino software on the Mac is a lot easier than on the PC. As before, the first step is to download the file. In the case of the Mac, it is a zip file.

Once downloaded, double-click on the zip file, which will extract a single file called ‘Arduino.app’. This is the whole Arduino application, just drag it into your Applications Folder.
You can now find and launch the Arduino software in your Applications folder. As you are going to use it frequently, you may wish to right-click its icon in the dock and set it to ‘Keep In Dock’.

There are many different LINUX distributions and the instructions for each distribution are a little different. The Arduino community has done a great job of putting together sets of instructions for each distribution.

**Boards and Ports**

You are now ready to start the Arduino Software, so whatever platform you are using, open the Arduino folder and open the Arduino application contained within it.
This will start the Arduino IDE, but before you can start programming, you have to tell the Arduino software which type of Arduino board you are using and also select the port to which it is connecting.

To tell the Arduino IDE which type of board you are using, from the 'Tools' menu, select Board and then 'Arduino Uno' or 'Leonardo' as appropriate.

Also on the 'Tools' menu, you will find the 'Serial Port' option. Select this option.
If you are using Windows, there will probably only be one option here and it will either say COM3 or COM4. Even though there is only one option, you will still need to select it.

If you are using a Mac or Linux, there will be more options there, but it will usually be the top option in the list, as this will be the device most recently plugged in. This is useful, as the name of the port may not look like it has anything to do with Arduino. It will probably be called something like /dev/tty.usbmodemXXXX or /dev/ttyUSBn.
Lesson 1 Add Libraries

Once you are comfortable with the Arduino software and using the built-in functions, you may want to extend its functionality with additional libraries.

What are Libraries?

Libraries are a collection of code that makes it easy for you to connect to a sensor, display, module, etc. For example, the built-in LiquidCrystal library makes it easy to talk to character LCD displays. There are hundreds of additional libraries available on the Internet for download. The built-in libraries and some of these additional libraries are listed in the reference. To use these additional libraries, you will need to install them.

How to Install a Library

Using the Library Manager

To install a new library into your Arduino IDE, you can use the Library Manager (available from IDE version 1.6.2). Open the IDE and click Sketch > Include > Library > Manage Libraries.

The library manager will open and you will find a list of libraries that are already installed or
ready for installation. In this example, we will install the Bridge library. Scroll down the list to find it, then select the version of the library you want to install. Sometimes, only one version of the library is available. If the version selection menu does not appear, don’t worry; it is normal.

![Library Manager](image)

Finally click on install and wait for the IDE to install the new library. Downloading may take time depending on your connection speed. Once it has finished, an Installed tag should appear next to the Bridge library. You can close the library manager.

![Library Manager](image)

You can now find the new library available in the Include Library menu. If you want to add your own library open a new issue on github.
Importing a .zip Library

Libraries are often distributed as a ZIP file or folder. The name of the folder is the name of the library. Inside the folder will be the following: .cpp file, .h file, often a keywords.txt file, examples folder, and other files required by the library. Starting with version 1.0.5, you can install third-party libraries in the IDE. Do not unzip the downloaded library; leave it as-is.

In the Arduino IDE, navigate to Sketch > Include Library > Add .ZIP Library.

You will be prompted to select the library you would like to add. Navigate to the .zip file’s location and open it.

Return to the Sketch > Import Library menu. You should now see the library at the bottom of the drop-down menu. It is ready to be used in your sketch. The zip file will have been expanded in the libraries folder in your Arduino sketches directory.

NB: The Library will be available to use in sketches, but examples for the library will not be shown in the File > Examples until after the IDE has restarted.

Manual installation

To install the library, first, quit the Arduino application. Then unzip the ZIP file containing the library. For example, if you’re installing a library called “ArduinoParty”, uncompress ArduinoParty.zip. It should contain a folder called ArduinoParty, with files like ArduinoParty.cpp and ArduinoParty.h inside. (If the .cpp and .h files aren’t in a folder, you’ll need to create one. In this case, you’d make a folder called “ArduinoParty” and move into it all the files that were in the ZIP file, like ArduinoParty.cpp and ArduinoParty.h.)

Drag the ArduinoParty folder into this folder (your libraries folder). Under Windows, it will likely
be called "My Documents\Arduino\libraries". For Mac users, it will likely be called "Documents/Arduino/libraries". On Linux, it will be the "libraries" folder in your sketchbook.

Your Arduino library folder should now look like this (on Windows):

- My Documents\Arduino\libraries\ArduinoParty\ArduinoParty.cpp
- My Documents\Arduino\libraries\ArduinoParty\ArduinoParty.h
- My Documents\Arduino\libraries\ArduinoParty\examples

....

or like this (on Mac and Linux):

- Documents/Arduino/libraries/ArduinoParty/ArduinoParty.cpp
- Documents/Arduino/libraries/ArduinoParty/ArduinoParty.h
- Documents/Arduino/libraries/ArduinoParty/examples

....

There may be more files than just the .cpp and .h files so make sure they're all there. (The library won't work if you put the .cpp and .h files directly into the libraries folder or if they're nested in an extra folder. For example: Documents\Arduino\libraries\ArduinoParty.cpp and Documents\Arduino\libraries\ArduinoParty\ArduinoParty\ArduinoParty.cpp won't work.)

Restart the Arduino application. Make sure the new library appears in the Sketch > Import Library menu. That's it. You've installed a library!

**Summary**

In this lesson, we will install all the libraries that we will use in the tutorial. Open the libraries folder and install the ZIP files one by one so we won't need to do this step in the following lessons. We just connect the component as the schematic and upload the code provided. Then the kit will work.
Lesson 2 TEMP AND HUMIDITY MODULE

Overview

In this tutorial we will learn how to use a DHT11 Temperature and Humidity Sensor. It’s accurate enough for most projects that need to keep track of humidity and temperature readings.

Again we will be using a Library specifically designed for these sensors that will make our code short and easy to write.

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x DHT11 module
(x) x F-M wires

Component Introduction

Temp and humidity sensor:
DHT11 digital temperature and humidity sensor is a composite sensor that contains a calibrated digital signal output of the temperature and humidity. Application of a dedicated digital modules collection technology and the temperature and humidity sensing technology, to ensure that the product has high reliability and excellent long-term stability. The sensor includes a resistive sense of wet components and an NTC temperature measurement devices, and connected with a high-performance 8-bit microcontroller.

Applications: HVAC, dehumidifier, testing and inspection equipment, consumer goods, automotive, automatic control, data loggers, weather stations, home appliances, humidity regulator, medical and other humidity measurement and control.

**Product parameters**

Relative humidity:

Resolution: 16Bit

Repeatability: ±1% RH

Accuracy: At 25°C ±5% RH

Interchangeability: fully interchangeable

Response time: 1 / e (63%) of 25°C 6s

1m / s air 6s

Hysteresis: <± 0.3% RH

Long-term stability: <± 0.5% RH / yr in

Temperature:

Resolution: 16Bit
Repeatability: ±0.2°C
Range: At 25°C ±2°C
Response time: 1 / e (63%) 10s

Electrical Characteristics
Power supply: DC 3.5~5.5V
Supply Current: measurement 0.3mA standby 60μA
Sampling period: more than 2 seconds

Pin Description:
1, the VDD power supply 3.5~5.5V DC
2 DATA serial data, a single bus
3, NC, empty pin
4, GND ground, the negative power

Typical Application

Connection
Schematic
wiring diagram
Result
Upload the program then open the monitor, we can see the data as below: (It shows the temperature of the environment, we can see it is 21 degree)
Lesson 3 DS18B20 DIGITAL TEMPERATURE SENSOR MODULE

Overview

In this experiment, we will learn how to use DS18B20 module test the environmental temperature and make a thermometer.

Since the previous temperature sensor output is analog. So we need to add additional A/D and D/A chip into the line transformation. More -over, the Arduino external port is not rich resources and the utilization rate is not high. These cause a big challenge. So we are create the Ds18b20 module.

The new DS18B20 Temperature Sensor Module is very good solve the problem. It have the characteristicoftheeconomy,unique1-wirebusanditcanfullyapplytheArduinoplatform. Users can easily forma sensor network through using this module.

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x DS18B20 module
(x) x F-M wires
Component Introduction

DS18B20:

**PIN ASSIGNMENT**

**BOTTOM VIEW**

**DS18B20 TO-92 PACKAGE**

**DS18B20Z 8-PIN SOIC (150-MIL)**

**PIN DESCRIPTION**

- GND - Ground
- DQ - Data In/Out
- $V_{DD}$ - Power Supply Voltage
- NC - No Connect
Principle

DS18B20 module is using a single bus. The power supply voltage range of 3.0 V to 5.5 V and no standby power supply. It can measure temperature range for -55 degree to +125 degree with accuracy of +/-0.5°C.

The programmable DPI of temperature sensor is from 9 to 12. Temperature conversion is 12 digits lattice type, maximum is 750 milliseconds. Families can be defined non-volatile temperature alarm Settings.

Each DS18B20 contains a unique serial number so that multiple ds18b20 can exist in a bus.

Connection

Schematic
wiring diagram
Result
Temperature sensor can detect temperature in numbers of different places at the same time.

Upload the program then open the monitor, we can see the data as below:
Lesson 4 BUTTON SWITCH MODULE

Overview

In this experiment, we will learn how to use button switch.

![Button Switch Module Diagram]

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x Button module
(x) x F-M wires

Component Introduction

PUSH SWITCHES:

Switches are really simple components. When you press a button or flip a lever, they connect two contacts together so that electricity can flow through them.

The little tactile switches that are used in this lesson have four connections, which can be a little confusing.
Actually, there are only really two electrical connections, as inside the switch package pins B and C are connected together, as are A and D.

**Principle**

BUTTON SWITCH and number 13 port have the built-in LED simple circuit. To produce a switch flasher, we can use connect the digital port 13 to the built-in LED and connect the BUTTON SWITCHS port to number3 port of Elegoo Uno board. When the switch sensing, LED twinkle light to the switch signal.

**Connection**

Schematic
wiring diagram

Result
Connect the circuit as above and upload the program. Then push the button, you can see led on and off.
Lesson 5 FOUR TYPE OF SWITCH MODULE

Overview

In this experiment, we will learn how to use switch modules.
Including shock switch module, mercury switch module, tilt switch module and knock switch module.
Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x Shock switch module
(1) x Mercury switch module
(1) x tilt switch module
(1) x Knock switch module
(x) x F-M wires

Principle

switch and number 13 port have the built-in LED simple circuit. To produce a SWITCH flasher, we can use connect the digital port 13 to the built-in LED and connect the SWITCH S port to number 3 port of Elegoo Uno board. When the SWITCH sensing, LED twinkle light to the SWITCH signal.

Connection
Schematic
wiring diagram
Result

![Diagram of the setup](image1.png)

![Diagram of the setup](image2.png)
Connect the circuit as above and upload the program. Then lean or shock the sensor, you can see led on and off.
Lesson 6 IR RECEIVER AND EMISSION

Overview

In this experiment, we will learn how to use Infrared Receiver and IR Emission module. In fact now in our daily life they play an important role, a lot of household electrical appliances are used to this kind of device, such as air conditioning, TV, DVD, etc. Actually it is based on its wireless remote sensing and it is very convenient by using them.

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x IR Receiver module
(1) x IR Emission module
Component Introduction

IR RECEIVER SENSOR:

IR detectors are little microchips with a photocell that are tuned to listen to infrared light. They are almost always used for remote control detection - every TV and DVD player has one of these in the front to listen for the IR signal from the clicker. Inside the remote control is a matching IR LED, which emits IR pulses to tell the TV to turn on, off or change channels. IR light is not visible to the human eye, which means it takes a little more work to test a setup.

There are a few difference between these and say a CdS Photocells:

IR detectors are specially filtered for Infrared light, they are not good at detecting visible light. On the other hand, photocells are good at detecting yellow/green visible light, not good at IR light

- IR detectors have a demodulator inside that looks for modulated IR at 38 KHz. Just shining an IR LED won’t be detected, it has to be PWM blinking at 38KHz. Photocells do not have any sort of demodulator and can detect any frequency (including DC) within the response speed of the photocell (which is about 1KHz)

- IR detectors are digital out - either they detect 38KHz IR signal and output low (0V) or they do not detect any and output high (5V). Photocells act like resistors, the resistance changes depending on how much light they are exposed to.

What You Can Measure
As you can see from these datasheet graphs, the peak frequency detection is at 38 KHz and the peak LED color is 940 nm. You can use from about 35 KHz to 41 KHz but the sensitivity will drop off so that it won't detect as well from afar. Likewise, you can use 850 to 1100 nm LEDs but they won't work as well as 900 to 1000 nm so make sure to get matching LEDs! Check the datasheet for your IR LED to verify the wavelength.

Try to get a 940 nm - remember that 940 nm is not visible light (it's Infra Red)!

**Principle**

Firstly, let's know the structure of the infrared receiving head: there are two important elements inside the infrared receiving head, IC and PD. IC is receiving head processing components, mainly composed of silicon and circuit. It is a highly integrated device. The main function is filter, plastic, decoding, amplification, etc. PD is a photosensitive diode. The main function is to receive the light signal.

Below is a brief working principle diagram:
Infrared emitting diode launch out the modulation signal and infrared receiver head will receive, decode, filter and soon to regain the signal.

Infrared emitting diode: keep clean and in good condition. All the parameters in the process of working shall not exceed the limit value (positive To the current 30~60mA, positive pulse current 0.3~1A, reverse voltage 5V, dissipation power 90mW, working temperature range -25~+80℃, and storage temperature range between 40~100℃, the welding temperature 260℃) infrared to be with a closed head should be matching use, otherwise it will influence the sensitivity.

**Connection**

**Schematic**
wiring diagram
Result
Lesson 7 Active and passive buzzer

Overview

In this experiment, we will learn how to use buzzer module.

With the Arduino we can complete a lot of interactive work, commonly what we used is the light shows. And we has been use the LED small lights in the experiment before. In this experiment we will make the circuit having noise. The common components that can make sound are buzzer and speakers. Compared to the speaker, buzzer is more simple and easy to use so in this experiment we adopts the buzzer.

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x Active buzzer module
(1) x Passive buzzer module
(x) x F-M wires

Component Introduction

Active Buzzer:
As a type of electronic buzzer with integrated structure, buzzers, which are supplied by DC power, are widely used in computers, printers, photocopiers, alarms, electronic toys, automotive electronic devices, telephones, timers and other electronic products for voice devices. Buzzers can be categorized as active and passive ones (see the following picture). Turn the pins of two buzzers face up, and the one with a green circuit board is a passive buzzer, while the other enclosed with a black tape is an active one.

The difference between an active buzzer and a passive buzzer is:
An active buzzer has a built-in oscillating source, so it will make sounds when electrified. But a passive buzzer does not have such source, so it will not tweet if DC signals are used; instead, you need to use square waves whose frequency is between 2K and 5K to drive it. The active buzzer is often more expensive than the passive one because of multiple built-in oscillating circuits.

Passive Buzzer:
Passive buzzer, in fact, just use PWM generating audio, drives the buzzer, allowing the air to vibrate, can sound. Appropriately changed as long as the vibration frequency, it can generate different sound scale. For example, sending a pulse wave can be generated 523Hz Alto Do, pulse 587Hz can produce midrange Re, 659Hz can produce midrange Mi. If you then with a different beat, you can play a song. Here be careful not to use the Arduino analog Write () function to generate a pulse wave, because the frequency analog Write () is fixed (500Hz), no way to scale the output of different sounds.

Distinguish between Active and Passive Buzzer
Teach you to distinguish between active and passive buzzer
Now a small buzzer on the market because of its small size (diameter of only 11 mm), light weight, low price, solid structure, and is widely used in a variety of needs audible electrical
equipment, electronic production and microcontroller circuits, etc.

From the exterior, two kinds of buzzer seems the same, but a closer look, a slight difference between the height of the active buzzer a, height of 9mm, and passive buzzer b height of 8mm. When the buzzer as the two pins are facing up, you can see there is a green circuit board is passive buzzer, no closed circuit boards with a vinyl is active buzzer.

Further determine the active and passive buzzer, you can also use a multimeter to test the resistance profile Rx1 file: buzzer with black pen then “+” pin, the red pen to touch on another pin back and forth, if trigger a cracking, cracking sound and the resistance only 8Ω (or 16Ω) is passive buzzer; If you can emit continuous sound, and the resistance in Europe and more than a few hundred, and is an active buzzer.

Active buzzer directly connected to the rated power (new buzzer has stated on the label) can be a continuous sound; rather passive electromagnetic buzzer and speaker are the same, you need to take in order to sound the audio output circuit.

**Connection**

**Schematic**
wiring diagram
Result

After we connect the circuit as the picture, we upload the program of each module. We can hear that the active buzzer can make sound in one voice. And the passive can sing a song.
Lesson 8 LASER MODULE

Overview

In this experiment, we will learn how to use laser module.

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x Laser module
(x) x F-M wires

Component Introduction

Laser sensor:
Laser basics

Connection
Schematic
Result

After we connect the circuit as the picture, we upload the program. We can see the module can emission lasers.
Lesson 9 SMD RGB MODULE AND RGB MODULE

Overview

In this experiment, we will learn how to use SMD RGB module and RGB module. Actually, the function of SMD RGB module and RGB module are almost the same. But we can choose the shape we like or we need.

SMD RGB LED module and RGB module are made from a patch of full-color LED. By adjusting the voltage input of R, G, B pins, we can adjust the strength of the three primary colors (red/blue/green) so as to implementation result of full color effect.

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x SMD RGB module
(1) x RGB module

(x) x F-M wires

Component Introduction

SMD RGB:

![Diagram of SMD RGB component](image)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Symbol</th>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forward Current</td>
<td>If</td>
<td>20</td>
<td>mA</td>
</tr>
<tr>
<td>Reverse Voltage</td>
<td>Vr</td>
<td>5</td>
<td>V</td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>Topr</td>
<td>-25~+85</td>
<td>℃</td>
</tr>
<tr>
<td>Storage Temperature</td>
<td>Tstg</td>
<td>-35~+85</td>
<td>℃</td>
</tr>
<tr>
<td>Soldering temperature</td>
<td>Tsol</td>
<td>260±5℃ (for 4 sec)</td>
<td>℃</td>
</tr>
<tr>
<td>Power Dissipation</td>
<td>Pd</td>
<td>R=40</td>
<td>mW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R=60</td>
<td></td>
</tr>
<tr>
<td>Pulse Current</td>
<td>IPp</td>
<td>100</td>
<td>mA</td>
</tr>
</tbody>
</table>

Tolerance is ±0.25mm (0.10”) unless otherwise noted.
Electrical / Optical Characteristics at TA=25°C

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Parameter</th>
<th>Device</th>
<th>Typ.</th>
<th>Max.</th>
<th>Units</th>
<th>Test Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>λpeak</td>
<td>Peak Wavelength</td>
<td>Hyper Red Blue</td>
<td>650</td>
<td></td>
<td>nm</td>
<td>Iᵣ=20mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Green</td>
<td>488</td>
<td>315</td>
<td></td>
<td></td>
</tr>
<tr>
<td>λD [1]</td>
<td>Dominant Wavelength</td>
<td>Hyper Red Blue</td>
<td>630</td>
<td></td>
<td>nm</td>
<td>Iᵣ=20mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Green</td>
<td>470</td>
<td>525</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Δλ1/2</td>
<td>Spectral Line Half-width</td>
<td>Hyper Red Blue</td>
<td>26</td>
<td></td>
<td>nm</td>
<td>Iᵣ=20mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Green</td>
<td>25</td>
<td>30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>Capacitance</td>
<td>Hyper Red Blue</td>
<td>35</td>
<td></td>
<td>pF</td>
<td>Vᵣ=0V,f=1MHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Green</td>
<td>100</td>
<td>45</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vᵢ [2]</td>
<td>Forward Voltage</td>
<td>Hyper Red Blue</td>
<td>1.95</td>
<td>2.5</td>
<td>V</td>
<td>Iᵣ=20mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Green</td>
<td>3.3</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3.3</td>
<td>4.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Iᵣ</td>
<td>Reverse Current</td>
<td>Hyper Red Blue</td>
<td>10</td>
<td></td>
<td>uA</td>
<td>Vᵣ=5V</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Green</td>
<td>50</td>
<td>50</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notes:
1. Wavelength: +/-1nm.
2. Forward Voltage: +/-0.1V.

Connection
Schematic
Result

After we connect the circuit as the picture, we upload the program of each module. We can see the module changing their color as the code set. If you want to make it change the color in different way, you can revise the code.
Lesson 10 PHOTO-INTERRUPTER MODULE

Overview

In this experiment, we will learn how to use Photo-interrupter module.

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x Photo-interrupter MODULE
(x) x F-M wires

Component Introduction

Opto Interrupter Sensor:

Opto Interrupters are commonly used in many arcade games e.g. steering assembly in
older driving games, scoring switches in Whack A Crock etc. Uninterrupted light beam will turn the phototransistor "ON" connecting the ground to the game board input. When the light beam is interrupted the phototransistor turns "OFF", the ground is disconnected from the input and the pull-up resistor R1 forces the input to go "HIGH" (5V level).

Principle

Photo-interrupter module and number 13 port have the built-in LED simple circuit. To produce a switch flasher, we can use connect the digital port 13 to the built-in LED and connect the Photo-interrupter MODULE S port to number 3 port of Elegoo Uno board. When the switch sensing, LED twinkle light to the switch signal.

Connection
Schematic

wiring diagram
Result

After we connect the circuit as the picture, we upload the program, we sensing the opto Interrupter, then we can see the LED13 light up and light off.
Lesson 11 DUAL-COLOR COMMON-CATHODE LED

Overview
In this experiment, we will learn how to use Dual-color Common-Cathode LED.

Component Required:
(1) x Elegoo Uno R3
(1) x USB cable
(2) x Dual-color Common-Cathode LED
(x) x F-M wires

Component Introduction
Dual-color Common-Cathode led:
**Electro-Optical Characteristics:** \((T_A = +25^\circ C \text{ unless otherwise specified})\)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Symbol</th>
<th>Test Conditions</th>
<th>Min</th>
<th>Typ</th>
<th>Max</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Angle of Half Power</td>
<td>(2\theta 1/2)</td>
<td>IF = 20mA</td>
<td>-</td>
<td>40</td>
<td>-</td>
<td>deg</td>
</tr>
<tr>
<td>Forward Voltage</td>
<td>VF</td>
<td>IF = 20mA</td>
<td>2.05</td>
<td>2.80</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>High Efficiency Red</td>
<td>VF</td>
<td>IF = 20mA</td>
<td>2.15</td>
<td>2.80</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>Luminous Intensity (Note 1)</td>
<td>IV</td>
<td>IF = 20mA</td>
<td>-</td>
<td>35</td>
<td>60</td>
<td>mcd</td>
</tr>
<tr>
<td>Peak Emission Wavelength</td>
<td>(\lambda_p)</td>
<td>IF = 20mA</td>
<td>-</td>
<td>625</td>
<td>-</td>
<td>nm</td>
</tr>
<tr>
<td>High Efficiency Red</td>
<td>(\lambda_p)</td>
<td>IF = 20mA</td>
<td>-</td>
<td>570</td>
<td>-</td>
<td>nm</td>
</tr>
<tr>
<td>Yellow-Green</td>
<td>(\lambda_d(HUE))</td>
<td>IF = 20mA</td>
<td>-</td>
<td>618</td>
<td>-</td>
<td>nm</td>
</tr>
<tr>
<td>Yellow-Green</td>
<td>(\lambda_d(HUE))</td>
<td>IF = 20mA</td>
<td>-</td>
<td>567</td>
<td>-</td>
<td>nm</td>
</tr>
</tbody>
</table>

1. Red +
2. Common Lead -
3. Green +
Connection
Schematic

wiring diagram
Result

After we connect the circuit as the picture, we upload the program of each module. We can see the module changing their color as the code set. If you want to make it change the color in different way, you can revise the code.
Lesson 12 PHOTORESISTOR MODULE

Overview

In this experiment, we will learn how to use the photo-resistor module. Photo-resistor is very common in our daily life, it is mainly used in intelligent switch so as to bring convenience to our life. At the same time, in our daily life, we also use it in electronic design. So in order to use it in a better, we provide the corresponding modules to help us to use it more conveniently and efficiently.

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x Photoresistor module
(x) x F-M wires

Component Introduction

PHOTOCELL:

The photocell used is of a type called a light dependent resistor, sometimes called an LDR. As the name suggests, these components act just like a resistor, except that the resistance changes in response to how much light is falling on them.

This one has a resistance of about 50 kΩ in near darkness and 500 Ω in bright light. To convert this varying value of resistance into something we can measure on an Arduino’s
analog input, it need to be converted into a voltage.

The simplest way to do that is to combine it with a fixed resistor.

The resistor and photocell together behave rather like a pot. When the light is very bright, then the resistance of the photocell is very low compared with the fixed value resistor, and so it is as if the pot were turned to maximum.

When the photocell is in dull light the resistance becomes greater than the fixed 1kΩ resistor and it is as if the pot were being turned towards GND.

Load up the sketch given in the next section and try covering the photocell with your finger, and holding it near a light source.

**Connection**

**Schematic**
Upload the program then open the monitor, we can see the data as below:
In the test, we only read the output analog voltage value of photo-resistor module. In the test results, we will find that when there is lighting, high voltage output equivalently of switch on, when there is no light, low voltage equivalently of switch off. This is what we can use this in practice.
Lesson 13 BIG SOUND SENSOR MODULE AND SMALL SOUND SENSOR MODULE

Overview
In this experiment, we will learn how to use the High-sensitive Voice Sensor.

Component Required:
(1) x Elegoo Uno R3
(1) x USB cable
(1) x Big sound sensor module
(1) x Small sound sensor module
(x) x F-M wires

Component Introduction
Sound sensor:
The sound sensor module provides an easy way to detect sound and is generally used for detecting sound intensity. This module can be used for security, switch, and monitoring applications. Its accuracy can be easily adjusted for the convenience of usage.

It uses a microphone which supplies the input to an amplifier, peak detector and buffer. When the sensor detects a sound, it processes an output signal voltage which is sent to a microcontroller then performs necessary processing.

Connection
Schematic
wiring diagram
Result
High-sensitive Voice Sensor has two output:

AO, analog output, real-time output voltage signal of microphone

DO, when the intensity of the sound to reach a certain threshold, the output high and low level signal, the threshold-sensitivity can be achieved by potentiometer adjustment period.

The module features:

The installation of 3mm screw holes use 5 v dc power supply have analog output turn a threshold level of output microphone GaoGan degree, high sensitivity. has a power light the comparator output indicator light. Upload the program then open the monitor, we can see the data as below:
Lesson 14 REED SWITCH AND MINI REED SWITCH MODULE

Overview

In this experiment, we will learn how to use reed switch and mini reed switch module.

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x Reed switch module
(1) x Mini Reed switch module
(x) x F-M wires
Component Introduction

Reed Switch and Reed Sensor Activation:
Although a reed switch can be activated by placing it inside an electrical coil, many reed switches and reed sensors are used for proximity sensing and are activated by a magnet. As the magnet is brought into the proximity of the reed sensor/switch, the device activates. As the magnet is removed from the proximity of the reed sensor/switch, the device deactivates. However, the magnetic interaction involved in activating the reed switch contacts is not necessarily obvious. One way of thinking about the interaction is that the magnet induces magnetic poles into the metal parts of the reed switch and the resulting attraction between the electrical contacts causes the reed switch to activate.

![Diagram of magnetic induction](image1)

**Figure 1 – Magnetic Induction**

Another equally valid way of thinking about the interaction between a magnet and a reed switch is that the magnet induces magnetic flux through the electrical contacts. When the magnetic flux is high enough, the magnetic attraction between the contacts causes the reed switch to close.

![Diagram of magnetic flux](image2)

**Figure 2 – Magnetic Flux**

The following are examples of typical reed switch and reed sensor activate distances.
### Difference between the reed switch module and mini reed switch module

As we can see, the reed switch module is bigger than the mini reed switch module. So the bigger one may have more function than the mini one. The reed switch can output in two ways: digital and analog. The mini reed can only output in digital.

In the 37 sensor kit, there have 7 red pcb modules. The difference between the red and small pcb is same as above.

### Principle

![Magnet Parallel to Reed Sw.](image1)

![Magnet Perpendicular to Reed Sw.](image2)

![Magnet Parallel to Reed Sw.](image3)

As can be seen, the magnetic orientation and location relative to the reed switch play important roles in the activation distances. In addition, the size of the activate regions (lobes) will vary depending on the strength of the magnet and the sensitivity of the reed switch. Proper orientation of the magnet with respect to the reed sensor/switch is an important consideration in meeting the application’s requirements across the tolerance range for mechanical systems, magnetic strength and reed sensor or reed switch sensitivity.
Connection of mini reed switch module

Schematic

wiring diagram
Upload the program. When the module access to magnetic, you can see the led on or off. Mini switch module and number 13 port have the built-in LED simple circuit. To produce a switch flasher, we can use connect the digital port 13 to the built-in LED and connect the switch module S port to number 3 port of Elegoo Uno board. When the switch sensing, LED twinkle light to the switch signal.

**Connection of reed switch module**

**Schematic**
wiring diagram
Result
In this experiment, we use the AO pin of reed switch module. When the sensor sensing magnetism, the module will output a data which reflect the strength of the magnetism. The number is from 0 to 1023.

Upload the program then open the monitor, we can see the data as below:
Lesson 15 DIGITAL TEMPERATURE MODULE

Overview

In this experiment, we will learn how to use a digital temperature module and an analog temperature module.

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x digital temperature module
(1) x temperature module
(x) x F-M wires
Component Introduction

Thermistor:

These thermistors have a narrow tolerance on the B-value, the result of which provides a very small tolerance on the nominal resistance value over a wide temperature range. For this reason the usual graphs of $R = f(T)$ are replaced by Resistance Values at Intermediate Temperatures Tables, together with a formula to calculate the characteristics with a high precision.

<table>
<thead>
<tr>
<th>RS stock no.</th>
<th>151-215</th>
<th>151-221</th>
<th>151-237</th>
<th>151-243</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resistance at $+25^\circ C$</td>
<td>3kΩ</td>
<td>5kΩ</td>
<td>10kΩ</td>
<td>100kΩ</td>
</tr>
<tr>
<td>Temperature range</td>
<td>$-55^\circ C$ to $+150^\circ C$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tolerance (0 to $+70^\circ C$)</td>
<td>$\pm 0.2^\circ C$</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dissipation constant</td>
<td>1mW</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time constant</td>
<td>10s</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Connection of digital temperature module
wiring diagram
Result

Upload the program, open the monitor then you can see the data as below:
Connection of temperature module

Schematic

wiring diagram
Result
In this experiment, we use the AO pin of reed switch module. When the sensor sensing temperature, the module will output a data which reflect the temperature. The number is from 0 to 1023.

Upload the program then open the monitor, we can see the data as below:
Lesson 16 LINEAR HALL AND ANALOG HALL MODULE

Overview

In this experiment, we will learn how to use the linear hall and analog hall module.

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x DHT11 module
(x) x F-M wires

Component Introduction

Hall Sensor:

ABSOLUTE MAXIMUM RATINGS
at $T_A = +25^\circ$C

Supply Voltage, $V_{CC}$ .......................... 28 V
Reverse Battery Voltage, $V_{RCC}$ .......... -35 V
Magnetic Flux Density, $B$ ........... Unlimited
Output OFF Voltage, $V_{OUT}$ .............. 28 V
Reverse Output Voltage, $V_{OUT}$ .......... -0.5 V
Continuous Output Current, $I_{OUT}$ ...... 25 mA

Operating Temperature Range, $T_A$
Suffix ‘E’ .......................... $-40^\circ$C to $+85^\circ$C
Suffix ‘L’ .......................... $-40^\circ$C to $+150^\circ$C

Storage Temperature Range,
$T_S$ .................................. $-65^\circ$C to $+170^\circ$C

$V_{hall} \propto I_c \times H$

$V_{hall} = \text{Output Hall-effect voltage}$
$H = \text{Magnetic Flux created by magnet or current-carrying conductor}$
$I_c = \text{Constant supply current}$
Design Factors – Magnetic Types

Unipolar: Only a south pole will operate the sensor. The sensor turns on with the south pole (+) and off when the south pole is removed.

• Bipolar: Sensor output is pole-dependent. A south pole (+) is designed to activate the sensor; a north pole (-) is designed to deactivate. It’s possible that the sensor could turn off and still be within a positive Gauss level.

• Latching: Specifications are tighter on latching. Sometimes it is designed to make certain that when the south pole (+) is removed from the sensor, it will stay on until it sees the opposite pole (-).

• Omnipolar: The sensor is designed to operate with either magnetic pole (+ or -).

• Ratiometric linear: Output is proportional to magnetic field strength. Output sensitivity range is 2.5 – 3.75 mV per unit of Gauss.

Connection
Schematic
wiring diagram
Result

For the hall sensor module, we can choose the output: digital output or analog output. In the following picture, we use the DO port to output. so we can see that if the hall sensor sensing the magnetic force, the light will turn on.
Connection
wiring diagram
Result

In the following picture, we use the AO port to output, so we can see that if the hall sensor sensing the magnetic force, the module will output a data which reflect the strength of the magnetic force. The number is from 0 to 1023.

Upload the program then open the monitor, we can see the data as below:

Upload the program then open the monitor, we can see the data as below:
Lesson 17 FLAME SENSOR MODULE

Overview

In this experiment, we will learn how to use the flame sensor module. This module is sensitive to the flame and radiation. It also can detect ordinary light source in the range of a wavelength 760nm-1100 nm. The detection distance is up to 100 cm. The Flame sensor can output digital or analog signal. It can be used as a flame alarm or in fire fighting robots.

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x Flame sensor module
(x) x F-M wires

Component Introduction

Flame sensor:

• Detects a flame or a light source of a wavelength in the range of 760nm-1100 nm
• Detection distance: 20cm (4.8V) ~ 100cm (1V)
• Detection angle about 60 degrees, it is sensitive to the flame spectrum.
• Comparator chip LM393 makes module readings stable.
• Adjustable detection range.
- Operating voltage 3.3V-5V
- Digital and Analog Output
  " DO digital switch outputs (0 and 1)
  " AO analog voltage output
- Power indicator and digital switch output indicator

Connection

Schematic

wiring diagram
Result
For the flame sensor module, we can choose the output: digital output or analog output. In the following picture, we use the DO port to output. so we can see that if the flame sensor sensing the flame, the light will turn on.

In the following picture, we use the AO port to output. so we can see that if the flame sensor sensing the flame, the module will output a data which reflect the strength of the flame. The number is from 0 to 1023.
Upload the program then open the monitor, we can see the data as below:
Lesson 18 MENTAL TOUCH MODULE

Overview

In this experiment, we will learn how to use the mental touch module.

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x Mental touch module
(x) x F-M wires

Connection

Schematic
wiring diagram
Result

For the mental touch module, we can choose the output: digital output or analog output. In the following picture, we use the DO port to output. so we can see that if the sensor sensing, the light will turn on.
In the following picture, we use the AO port to output. so we can see that if the sensor sensing, the module will output a data. The number is from 0 to 1023.
Upload the program then open the monitor, we can see the data as below:
Lesson 19 7 COLOR FLASH LED MODULE

Overview

In this experiment, we will learn how to use the 7 color flash LED module.

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x 7 color flash led module
(x) x F-M wires

Component Introduction

7 color flash led:

7 color flashing LED module automatically uses 5mm round high-brightness light-emitting diode which has the following characteristics:

Product Type: LED
Product Model: YB-3120B4PnYG-PM
Shape: Round LED 5mm DIP type
Color: pink yellow green (high brightness)
Lens type: white mist
Standard Forward Voltage :3.0-4 .5 V
Connection
Schematic

[Diagram of Arduino Uno (Rev3) with labels for pins]

wiring diagram
Result
Lesson 20 Magic light cup MODULE

Overview

In this experiment, we will learn how to use the light cup module.

![Image of Magic Light Cup module]

1. LED
2. OUTPUT
3. VCC: 3.3V-5V DC
4. GND: ground

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(2) x Magic Light Cup module
(x) x F-M wires

Component Introduction

Magic light cup module:

Magic light cup module is a product which can easily interact with the ARDUINO module, the principle is to use the PWM dimming, change the brightness of the two modules. Mercury switch provides digital signal, trigger PWM adjustment. through the design program, we can see the result which is similar to the effect of two cup full of light pouring to each other.

Connection
Schematic

wiring diagram
Result
Lesson 21 JOYSTICK MODULE

Overview

Just like a joystick on game console, you can control x, y and z dimensions input by this joystick module. It can be considered as combination of potentiometers and one button. Data type of the x, y dimensions are analog input signals and z dimension is digital input signal. thus the x and y ports connect to analog pins of Sensor Shield, while z port connects to digital pin.

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x Joystick module
(x) x F-M wires

Component Introduction

Joystick sensor:

Lots of robot projects need joystick. This module provides an affordable solution. By simply connecting to two analog inputs, the robot is at your commands with X, Y control. It also has a switch that is connected to a digital pin. This joystick module can be easily connected to Arduino by IO Shield. This module is for Arduino (V5) with cables supplied.

Specification
Supply Voltage: 3.3V to 5V
Interface: Analog x2, Digital x1
Size: 40*28mm
Weight: 12g

The module has 5 pins: Vcc, Ground, X, Y, Key. Note that the labels on yours may be slightly different, depending on where you got the module from. The thumb stick is analog and should provide more accurate readings than simple ‘directional’ joysticks. Tact use some forms of buttons, or mechanical switches. Additionally, you can press the joystick down (rather hard on mine) to activate a ‘press to select’ push-button.

We have to use analog Arduino pins to read the data from the X/Y pins, and a digital pin to read the button. The Key pin is connected to ground, when the joystick is pressed down, and is floating otherwise. To get stable readings from the Key/Select pin, it needs to be connected to Vcc via a pull-up resistor. The built-in resistors on the Arduino digital pins can be used. For a tutorial on how to activate the pull-up resistors for Arduino pins, configured as inputs.

### Connection

#### Schematic
wiring diagram
Result

Analog joysticks are basically potentiometers so they return analog values. When the joystick is in the resting position or middle, it should return a value of about 512. The range of values go from 0 to 1024.
Lesson 22 TRACKING MODULE

Overview

In this experiment, we will learn how to use the tracking module and avoidance module.

Infrared obstacle avoidance sensor is designed for the design of a wheeled robot obstacle avoidance sensor distance adjustable. This ambient light sensor Adaptable, high precision, having a pair of infrared transmitter and receiver, transmitter tubes emit a certain frequency of infrared, When detecting the direction of an obstacle (reflector), the infrared receiver tube receiver is reflected back, when the indicator is lit, Through the circuit, the signal output interface output digital signal that can be detected by means of potentiometer knob to adjust the distance, the effective distance From 2 ~ 40cm, working voltage of 3.3V-5V, operating voltage range as broad, relatively large fluctuations in the power supply voltage of the situation Stable condition and still work for a variety of microcontrollers, Arduino controller, BS2 controller, attached to the robot that can sense changes in the ir surroundings

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x Tracking module
(x) x F-M wires
Component Introduction

Connection

Schematic

wiring diagram
Result
Upload the program then open the monitor, we can see the data.
Lesson 23 Infrared 38KHz obstacle avoidance module

Overview
Non logic chip oscillation frequency regulation 38KHz detection circuit. This infrared 38KHZ obstacle avoidance module can completely block the traditional photoelectric obstacle detection distance and a single normally open or normally closed signal output function.

Component Required:
(1) x Elegoo Uno R3
(1) x USB cable
(1) x Obstacle avoidance module
(x) x F-M wires

Component Introduction
Obstacle avoidance module:
Specifications
Working voltage: DC 3.3V-5V
Working current: ≥ 20mA
Operating temperature: -10 °C - +50 °C
detection distance: 2-40cm
IO Interface: 4-wire interfaces (- / + / S / EN)
Output signal: TTL level (low level there is an obstacle, no obstacle high)
Adjustment: adjust multi-turn resistance
Effective angle: 35 °
Size: 28mm × 23mm
Weight Size: 9g

The basic concept of IR (infrared) obstacle detection is to transmit the IR signal (radiation) in a direction and a signal is received at the IR receiver when the IR radiation bounces back from a surface of the object.
There are two potentiometers on the module one controlling operating frequency (centered at 38 kHz) the other controlling intensity. The detector was designed for 38 kHz and the onboard oscillator circuit is based on a 555 timer. Tweaking gives a little better range but I’d suggest leaving it alone because the useful range is narrow.

Infrared obstacle avoidance sensor is designed for the design of a wheeled robot obstacle avoidance sensor distance adjustable. This ambient light sensor Adaptable, high precision, having a pair of infrared transmitter and receiver, transmitter tubes emit a certain frequency of infrared, When detecting the direction of an obstacle (reflector), the infrared receiver tube receiver is reflected back, when the indicator is lit, Through the circuit, the signal output interface output digital signal that can be detected by means of potentiometer knob to adjust the distance, the effective distance From 2 ~ 40cm, working voltage of 3.3V-5V, operating voltage range as broad, relatively large fluctuations in the power supply voltage of the situation Stable condition and still work for a variety of microcontrollers, Arduino controller, BS2 controller, attached to the robot that Can sense changes in their surroundings.
Connection
Schematic
wiring diagram

Result
Here we use the obstacle avoidance module and a digital interface, built-in 13 LED build a simple circuit, making avoidance warning lamp, the obstacle avoidance Sensor Access Digital 3 interface, when obstacle avoidance sensor senses a signal, LED light, and vice versa off.
Lesson 24 ROTARY ENCODERS MODULE

Overview

In this experiment, we will learn how to use the rotary encoders module.

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>CLK</td>
</tr>
<tr>
<td>2.</td>
<td>DT</td>
</tr>
<tr>
<td>3.</td>
<td>SW</td>
</tr>
<tr>
<td>4.</td>
<td>VCC: 3.3V-5V DC</td>
</tr>
<tr>
<td>5.</td>
<td>GND: ground</td>
</tr>
</tbody>
</table>

Component Required:

1. x Elegoo Uno R3
2. x USB cable
3. x Rotary Encoders module
4. x F-M wires

Component Introduction

Rotary Encoders:

**Mechanical Specifications:**
- Operating Temp: -10°C to 70°C
- Storage Temp: -40°C to 85°C
- Rotational Torque: 50gf.cm max.
- No. and Pos. of detents: 12 detents (Step angle 30°±3°)
- Terminal Strength: A static load for 300gf.cm shall be applied to the tip of the terminals for 10 sec. in any direction
- Shaft push-pull strength: 5.1kgf
- Rotational life: 30,000 cycles

**Electrical Specifications:**
- Rating: 1mA/10VDC
- Insulation Resistance: 50VDC 10MΩ Min.
- Dielectric Strength: 50VAC for 1 min.
- Resolution: 12 pulses/360° for each phase

**Soldering Specifications:**
- Soldering: To be performed in 5 seconds within 260±5°C
- Manual Soldering: To be performed in 3 seconds within 350±5°C
- Preheating: The entire flow duration should not exceed 2 min., and soldering surface temperature (undersurface of PCB) shall be settled within 100°C

**Push-on Switch Specifications:**
- Type: Single Pole Single Throw (Push on)
- Rating: 10mA/5VDC
- Switch Travel (mm): 0.5±0.4
- Operating Force: 200-400gf
- Operating Life: 20,000 times

Note:
- RoHS Compliant
Principle

Incremental encoder

Incremental encoders give two-phase square wave, the phase difference between them 90°, often referred to as A and B channels. One of the channels is given and speed-related information, at the same time, by sequentially comparing two channel signals, the direction of rotation of the information obtained. There is also a special signal called Z or Zero channel, which gives the absolute zero position encoder, the signal is a square wave with the center line of channel A square wave coincide.

Clockwise counterclockwise
Incremental encoder accuracy depends on the mechanical and electrical two factors, these factors are: Raster indexing error, disc eccentricity, bearing eccentricity, e-reading. Several means into the optical portion of the errors and inaccuracies. Determine the encoder resolution is measured in electrical degrees, the encoder accuracy depends on the pulse encoder generates indexing. The following electrical degrees with a 360 ° rotation of the shaft to said machine, and rotation of the shaft must be a full week of Period. To know how much electrical equivalent of the mechanical angle of 360 degrees can be calculated with the following formula: \[ \text{Electrical 360} = \frac{\text{Machine 360 °}}{n \text{ ° pulses} / \text{revolution}} \]

Encoder indexing error is the electrical angle of the unit two successive pulse maximum offset to represent. Error exists in any encoder, which is caused by the aforementioned factors. Eltra encoder maximum error is ± 25 electrical degrees (declared in any condition), equivalent to the rated Offset values ± 7%, as the phase difference 90 ° (electrical) of the two channels of the maximum deviation ± 35 electrical degrees is equal to ± 10% deviation.

**Connection**

**Schematic**
wiring diagram
Result
Upload the program, rotate the encodes then open the monitor, we can see the data as below:
Lesson 25 1 CHANNEL RELAY MODULE

Overview

In this experiment, we will learn how to use the 1 channel relay module.

Relay is a kind of component when the change of the input variables (incentive) to specified requirements, the output electric circuits of the charged amount occurs due to the step change of a kind of electrical appliances. This company produces the relay module can meet in 28 v to 240 v ac or dc power to control all kinds of other electric parts. MCU can be used to achieve the goal of timing control switch. Can be applied to guard against theft and alarm, toys, construction and other fields. Relay is an electrical control device. It has a control system (also called input circuit) and control system (also called the output circuit), the interaction between. Usually used in automatic control circuit, it is actually with a small current to control large current operation of a kind of "automatics

Component Required:

(1) x Elegoo Uno R3
(1) x USB cable
(1) x 1 channel relay module
(x) x F-M wires

Component Introduction

Relay:
A relay is an electrically operated switch. Many relays use an electromagnet to mechanically operate a switch, but other operating principles are also used, such as solid-state relays. Relays are used where it is necessary to control a circuit by a low-power signal (with complete electrical isolation between control and controlled circuits), or where several circuits must be controlled by one signal. The first relays were used in long distance telegraph circuits as amplifiers: they repeated the signal coming in from one circuit and re-transmitted it on another circuit. Relays were used extensively in telephone exchanges and early computers to perform logical operations.

A type of relay that can handle the high power required to directly control an electric motor or other loads is called a contactor. Solid-state relays control power circuits with no moving parts, instead using a semiconductor device to perform switching. Relays with calibrated operating characteristics and sometimes multiple operating coils are used to protect electrical circuits from overload or faults; in modern electric power systems these functions are performed by digital instruments still called "protective relays".

Below is the schematic of how to drive relay with Arduino (download from the arduino.cc)

Connection
Schematic
wiring diagram
Lesson 26 HEARTBEAT MODULE

Overview

This project uses bright infrared (IR) LED and a phototransistor to detect the pulse of the finger, a red LED flashes with each pulse. Pulse monitor works as follows: The LED is the light side of the finger, and phototransistor on the other side of the finger, phototransistor used to obtain the flux emitted, when the blood pressure pulse by the finger when the resistance of the photo transistor will be slightly changed. The project's schematic circuit as shown. We chose a very high resistance resistor R1, because most of the light through the finger is absorbed, it is desirable that the phototransistor is sensitive enough. Resistance can be selected by experiment to get the best results. The most important is to keep the shield stray light into the phototransistor. For home lighting that is particularly important because the lights at home mostly based 50HZ or 60HZ fluctuate, so faint heartbeat will add considerable noise.

When running the program the measured values are printed. To get a real heartbeat from this could be challenging.

Component Required:

(1) x Elegoo Uno R3

(1) x USB cable

(1) x Heartbeat module
Connection
Schematic

(x) x F-M wires

![Connection Schematic](http://www.elegoo.com)

wiring diagram
Result

Upload the program then open the monitor, we can see the data as below:
<table>
<thead>
<tr>
<th>1023, 255, 75</th>
<th>1023, 417, 55</th>
<th>1023, 591, 42</th>
<th>1023, 699, 32</th>
<th>1023, 780, 24</th>
<th>1023, 840, 93</th>
<th>1001, 885, 95</th>
<th>1001, 924, 21</th>
<th>1020, 945, 16</th>
</tr>
</thead>
<tbody>
<tr>
<td>1023, 964, 62</td>
<td>1017, 977, 71</td>
<td>1023, 999, 04</td>
<td>1023, 997, 53</td>
<td>1003, 1003, 89</td>
<td>1023, 1008, 87</td>
<td>1020, 1011, 50</td>
<td>1020, 1013, 83</td>
<td>1020, 1045, 22</td>
</tr>
</tbody>
</table>